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Transform Nutrition West Africa
Recent years have witnessed a growing political commitment to addressing the high rates of maternal
and child malnutrition in the West Africa region. Such commitment needs to be effectively translated
into appropriate policy choices and program action if it is to generate sustained change at scale.
Transform Nutrition West Africa therefore aims to improve and support policy and program decisions
and actions to accelerate reductions in maternal and child malnutrition through an inclusive process
of knowledge generation and mobilization throughout the region.
Within the project, we produced various high-quality evidence notes that aim to inform policy and
program decision-making. The topics are based on partner priorities and on current challenges and
evidence gaps in the region. The underlying methodological approach to synthesizing the evidence is
founded on rapid review methodology. We have developed and used templates that are a useful
tool for researchers and decisionmakers to produce quality evidence reviews in a timely manner in
low- and middle-income settings. The procedures to follow, the templates, and the relevant
resources are compiled in this resource bank.
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Context
Rapid review approaches: The why and how
Decisionmakers (including implementers,
policymakers, technical agencies) require accurate
and relevant evidence by which to plan, develop,
“A rapid review is a form of knowledge
and implement nutrition and health programs in a
synthesis that accelerates the process of
timely fashion. They need to know the
conducting a traditional systematic review
effectiveness of interventions and policies, how
through streamlining or omitting various
and in what settings these interventions work, and
methods to produce evidence for
their cost-effectiveness. Systematic reviews are
stakeholders in a resource-efficient
increasingly used to inform policy decisions and
manner” (Hamel et al. 2020).
produce guidance for health systems. Production
of systematic reviews, however, is often
protracted, resource intensive, and incompatible with decision-making timelines; they can take one
to two years to complete. Rapid reviews offer an alternative, rapid and timely approach to providing
actionable and relevant evidence that can be used to inform decisions about health systems in both
routine and emergency contexts (Figure 1). Rapid reviews are generated through a transparent,
scientific, and reproducible method that preserves key principles of knowledge synthesis.
Rapid review: A definition

Figure 1. Timeline of different methodological approaches

Source: Tricco, Langlois, Straus 2017.
Rapid reviews lack consensus on a definition and common processes (Hamel et al. 2020), though the
recently published Cochrane guidance is highly recommended (click here to show Garritty et al.
2021). Rapid reviews vary in scope and methodology and their timeline can vary from a few days to
several months. High quality review products are achieved within such a short timeframe through
one of two means: either more reviewers and/or technology are used (accelerating the process at
an increased cost), and/or recognized shortcuts are used to adapt systematic review methods
(abbreviating the process); in both cases, high quality is aimed for. Table 1, below, provides an
overview of what can be altered in this process. To minimize potential bias, each step in this
resource bank should be completed (Figure 2). There needs to be clear reporting of the final
approach taken and its limitations, particularly in terms of potential bias and the shortcomings of the
conclusions.
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The most common types of rapid reviews include:
1.
2.
3.
4.
5.
6.
7.
8.

Rapid review of effectiveness
Rapid qualitative evidence synthesis
Rapid review of cost-effectiveness
Rapid mixed studies review
Rapid realist review
Mapping review
Scoping review
Review of reviews

Table 1. Dimensions of standard systematic reviews that may be altered in rapid products
Dimension
Scope

Options
Limit number of research questions
Limit number of interventions and comparators or outcomes, with a
focus on those most important for decision-making
Comprehensiveness
Limit the search strategy (for example, reduce the number of databases
searched, omit grey literature, and limit dates, settings and languages
when justifiable)
Limit study types (systematic reviews only, randomized controlled trials
only)
Limit data extraction to a minimum set of required data items
Rigor/quality control
Limit dual study screening (for example, 20 percent of studies are dual
screened)
Limit dual data extraction (for example, only dual extract for outcomes)
Limit or eliminate internal or external review of final output, for
example, peer review (have an information specialist review the search
syntax)
Use a single reviewer to extract data using a piloted form; use a second
reviewer to check for correctness and completeness of extracted data
Synthesis
Limit or eliminate risk of bias or quality assessment of individual studies
Limit or eliminate strength/quality assessments of evidence synthesis
(for example, by using GRADE or by using a single reviewer to grade the
certainty of evidence, with verification of all judgments and footnoted
rationales by a second reviewer)
Reporting
Use processes related to report production to minimize time investment
(for example, use standard templates, software, and spreadsheets to
prove charts and tables and to extract data directly into tables)
Source: Adapted by the research team from Hartling et al. 2015; Garritty et al. 2021.
Fit for purpose: When to consider a rapid review product instead of other types of evidence reviews
A rapid review should be driven by the need for timely evidence to inform decision-making; this can
include urgent and emergent health issues and occasions when there is a need for a response to
questions of high priority to decisionmakers (Garritty, Norris, Moher 2017). Pandor et al. (2019)
provide a decision tool which allows for selection of the most appropriate rapid review approach. It
asks the following questions:
•

Is a rapid review the right fit for the end user’s decision or need?
o A rapid review approach can be used where trade-offs between benefits and harms
are not known to be significant. For uses demanding high accuracy (for example,
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•
•

national guidelines and drug licensing decisions), a more comprehensive approach is
probably the best option (Marshall et al. 2019).
o A close relationship with end users needs to be established, as iterative feedback is
essential.
Is a rapid review the right fit for the available evidence base?
Is a rapid review the right fit according to the available staff skillset and/or the capacity to
quickly mobilize skilled and experienced staff?

A rapid review resource bank
Within Transform Nutrition West Africa, we produced various high-quality evidence notes that
aimed to inform policy and program decision-making. The topics were based on partner priorities
and on current challenges and evidence gaps in the region. The underlying methodological approach
to synthesizing the evidence was founded on rapid review methodology. Throughout the project, we
developed and used procedures and templates to respond rapidly to requests from West African
stakeholders.
This resource bank aims to share this experience and provides practical guidance on how to conduct
a rapid review in response to stakeholders’ requests. It offers a step-by-step guide to conducting a
rapid review, complete with fillable templates for each step in the process, as applied in a low- and
middle-income setting (Figure 2). It is designed as an accessible and useful tool for researchers and
decisionmakers to produce high-quality evidence in a timely manner. As such, it helps fill a gap in the
use of rapid reviews—created using rigorous and systematic methods—in low- and middle-income
settings (Tricco, Langlois, Straus 2017).
Figure 2. Stepwise approach to conducting a rapid review
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Step 1. Topic selection and refinement
Topic selection and refinement engages with both technical processes and stakeholder values.
Technically, the review team must ensure that (1) the topic can be addressed by research evidence,
(2) it is not already covered by existing systematic reviews, and (3) sufficient quantity and quality of
evidence exists. Scoping literature searches are therefore essential in mapping existing coverage of
the evidence. The aim is to identify an informative sample of systematic reviews and key primary
research within the topic area. Information on the quantity and quality of the available evidence is
required in order to discuss the feasibility of the topic with the main stakeholders. Stakeholder
values are elicited to reveal whether the chosen topic (1) fits within the mandate and responds to
the priorities of the commissioning organization, (2) is important and meaningful to the target
population, and (3) holds potential for a significant impact on population health (Eder et al. 2012).
One of the biggest differences between rapid review products and conventional systematic reviews
is the intensified involvement of stakeholders and end users throughout the rapid review process
(Feldmann, Puhan, Mütsch 2019). Key review users such as policymakers, decisionmakers and health
professionals, are involved in setting and refining the topic selection, translating it into a research
question, and defining the outcomes of interest. They are usually consulted throughout the process
to ensure that the rapid review remains fit for purpose and is relevant and applicable to decisionmaking processes (Figure 3). Critical aspects of any rapid review product are therefore the credibility
of those producing the rapid reviews, the relevance of the topic and related research question, and
the trusted relationship between those delivering the rapid review and those using it (Hartling et al.
2017).
Figure 3. Potential entry points for end-user engagement in the review process

Source: Tricco, Langlois, Straus 2017.

Although rapid reviews can be produced at a lower cost than systematic reviews, production of such
reviews remains a resource-intensive process and intensive engagement with stakeholders may
result in additional time and resource needs. Not only must the time and resources expended on a
topic be considered, but that same time and those same resources could be equally targeted at an
area of genuine need, constituting an “opportunity cost”. Inappropriate topic selection or a
misalignment between a question and the conducting of the review to answer that question can
result in ineffective decision support or in the production of research waste.
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The process in detail
Topic selection: Prioritization
A review team should always seek to align its topic selection with the overall goals of the program.
This requires that the team and stakeholders impartially and consistently apply predefined and
explicit criteria to potential topics. It is important to involve stakeholders in the prioritization of
topics, whether the competition for priority takes place within the stakeholders’ area of interest or
across program budget areas. At all times the prioritization process should remain transparent and
accountable. Upon completion of each project, the team should continually evaluate and improve
the review process, realigning modified review processes to new value statements as and when they
are produced.
A research topic usually starts as a broad field of interest. It can begin with the formulation of what
is typically known as a background question, which may start as just a population and a problem, or
as a problem and some candidate interventions. Candidate topics are evaluated by a topicprioritization group which represents both stakeholders and technical review perspectives; topics
are reviewed for: appropriateness (does the topic fit within the program), importance, potential for
duplication of existing research, and feasibility (does the topic call for a type and volume of research
that is appropriate for a rapid review). Potential for duplication can be established using specialist
review databases such as Epistemonikos, PDQ for Informed Health Policymaking, or Health Systems
Evidence.
Topic refinement
Once an initial scoping has been conducted, the team can formulate more detail. At that point, it can
draw up a foreground question together with population, intervention and outcome elements,
including a comparison where possible (see STEP 2). This level of specification includes topic
refinement, in order to avoid the overlap that may occur with systematic and rapid reviews in similar
topic areas. Stakeholders can then assess the potential value and impact of a rapid review.
Further considerations can include an assessment of the extent to which the rapid review intends to
address a need for synthesized research, one which can remain unmet because of the potentially
uncoordinated nature of national and international efforts in this area. The overall aim of topic
selection and refinement is to engage diverse stakeholders in program decisions while also achieving
efficiency and timeliness. For more information on how rapid reviews are used to connect
researchers and policymakers, see the see the WHO’s Rapid Reviews to Strengthen Health Policy and
Systems: A Practical Guide (Tricco, Langlois, Straus 2017).
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Step 2. Research question
After topic selection and refinement has produced a foreground question, a detailed research
question must be developed.
Research question: Free text
The research question emerges from the topic to be explored and should be clearly articulated and
answerable. Quantitative research generally answers questions related to interventions, harm,
diagnosis, and economics, while qualitative research is used to explore questions related to meaning
or lived experience. Table 2 shows some sample phrasing of research questions in free text.
Table 2. Principal types of review question, with exemplars and indicative type of research
Types of review Sample research questions
questions
Intervention
What is the effect of an intervention or program on one or
more outcomes?
Harm/causation
What is the relationship between a risk factor and an
outcome?
Diagnosis
What is the extent to which a tool accurately identifies the
presence of a disease or health condition?
Economics
How do two or more interventions compare in relation to
their relative cost for achievement of an expected outcome?
Meaning/lived
What is the lived experience of a process or phenomenon?
experience
Source: Authors.

Research
Quantitative
Quantitative
Quantitative
Quantitative
Qualitative

Research question: Question frameworks
Using a framework to structure the research question
Several tools and frameworks are available to help
Top Tip! Your question may not fit
structure the research question. The use of a question
perfectly into a framework. Just
framework helps infuse detail into the more general
using part of a framework can be
research question that has been formulated; it also helps
sufficient.
identify whether it is to be addressed by quantitative
and/or qualitative research. Table 3 offers a generic
template that can be used to explore the scope and elements of the chosen topic. Depending on the
research question, other frameworks may be applicable; these can include the PICO(S) framework
for quantitative reviews (see Table 4), SPIDER for qualitative and mixed methods (Cooke, Smith, and
Booth 2012), SPICE for qualitative evidence (Booth 2006), or ECLIPSE for health services information
(Wildridge and Bell 2002). Use this template to develop your own question framework: Template –
Question Frameworks
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Table 3. Topic domains to be addressed by quantitative and qualitative question components

Findings/th
emes
Ql

Outcomes
Secondary
Qn

Timing
Qn + Ql

Primary

Comparison(s)
Qn

Evaluation

Qn

Interventions
Qn + Ql

Ql

Interest

Perspective
Secondary
Ql

Population
Qn + Ql

Primary

Environment
Ql

Phenomenon of
interest

Ql

Setting

Person

Qn + Ql

Context

Source : Authors
Note: Qn = quantitative; Ql = qualitative.
Table 4. PICO(S) question framework
P
Population/
participants

I
Intervention/
exposure

C
Comparison/
control

Which populations
are of interest?

What
interventions/progr
ams/risk factors
will be included?

What
intervention/expos
ure (risk or
protective factor) is
this being
compared to (a
comparison is not
always necessary)?
Source: Authors

O
Outcome

(S)
Study setting

What does the
study hope to
accomplish,
improve, or affect?

Where is the study
set, for example, in
a specific country
or community, or in
a hospital?

Equity considerations
Question frameworks may need to consider the social determinants of health. Considerations may
include how a policy or program addressed health inequities or how health outcomes differ across
groups. A specific population therefore needs to be defined, as do factors related to inequity
(Maden 2016; Maden et al. 2018). The PROGRESS-Plus criteria in Figure 4 provides a framework for
systematically considering the entry points for inequities that may be of concern in a given context
(O’Neill et al. 2014). A worked example can be found in Figure 5, and more information on this tool
can be accessed at: https://methods.cochrane.org/equity/projects/evidence-equity/progress-plus.
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Figure 4. PROGRESS-Plus framework

Plus other
possible factors
such as disease
status or
disability
Source: Cochrane Methods Equity (2021).
Figure 5. Sample equity lens research questions

How effective is an
intervention?

How do the social
determinants of health
influence the effectiveness
of the intervention?
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How does increased
physical activity impact on
childhood obesity?

Equity lens question

Does the impact of
increased physical activity
on childhood obesity differ
by child ethic background
and socioeconomic status?
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Step 3. Protocol development
Once the research question is finalized, the rapid review protocol can be developed. This protocol is
essential for ensuring transparency, providing structure, defining the scope, and upholding rigorous
standards for the rapid review process. It also enables clear communication with stakeholders about
the key elements of the review. The protocol serves as a roadmap for the review process ahead and
thus should be created at the beginning.
Best practice in systematic reviews requires following the PRISMA–P checklist (Preferred Reporting
Items for Systematic Reviews and Meta-Analyses—Protocol) (Shamseer et al. 2015; Moher et al.
2015). A protocol checklist for rapid reviews (PRISMA–RR) is under development. In anticipation of
this protocol guidance, Transform Nutrition West Africa has developed a checklist for a rapid review
protocol (Table 5). This includes the essential sections of the PRISMA–P in a condensed form,
(adapted for our own rapid review protocols) and all the areas that need to be considered when
conducting a rapid review. Once all the steps within this resource bank have been completed, then
all the components for the protocol will have been compiled and the rapid review process can begin.

Table 5. Rapid review protocol checklist: Recommended items to include in a rapid review protocol
Checklist item

Step

Administrative information
Title: Informative title indicating that this is a protocol
Registration:
Details of protocol availability
Clear indication of protocol document status
Identification of any updates/changes made to the protocol
Authors: Identification of review team

Link to
Step 3

Conflict of interest
Introduction
Topic selection and refinement
Details on stakeholders and stakeholder engagement
Description of the background to the specific topic selected
Research question
Description of the research question (free text)
Details of the research question using the questions framework
elements
Relevant definitions for the topic and/or the framework used for the
rapid review (if applicable)
Methods
Overall review typology
State the method applied to the rapid review
Eligibility criteria
List the eligibility criteria using the questions framework elements
Searching for evidence
State the search methods applied, including information sources and
the search strategy
Screening and study selection
State the methods for screening and study selection including data
management
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Link to
Step 1
Link to
Step 2

Link to
Step 4
Link to
Step 5
Link to
Step 6

Page number

Notes

Data extraction
State the data-extraction procedures, including the variables for which
data will be extracted
Quality assessment
If applied in the rapid review, report the quality assessment (risk-ofbias) tools applied
Knowledge synthesis
Describe the methods of synthesis and analysis
Dissemination
Report production and dissemination
Report plans for output and dissemination

Link to
Step 7
Link to
Step 8
Link to
Step 9
Link to
Step 10

Protocol registration
Once your protocol is finalized, and ideally before the rapid review process begins, it is best practice
to make it publicly available. Preregistration helps to limit the risk of potential bias. Any changes
made throughout the process need to be recorded. PROSPERO is the preferred platform for
registering protocols for systematic reviews; it now also accepts rapid reviews, as well as reviews of
reviews (umbrella reviews). An example of a rapid review protocol developed and published in
PROSPERO from Transform Nutrition West Africa can be found online: The Evidence Mapping of
Wasting Programmes and Their Impact Along the Continuum of Care for Wasting in Low- and
Middle-income Countries: A Rapid Review Protocol.
The following routes offer alternative options for protocol registration:
•

•

•
•

Title registration with the Joanna Briggs Institute:
Top Tip! In order to minimise the
This does not ensure rigor or that standards of
chance that someone else is already
acceptance will be met, but it does provide an
undertaking similar work, it is a
audit trail of the protocol before completion.
good idea to check these registries
Protocol registration with the Open Science
before
commencing a review.
Framework: Here are found many more scoping
reviews than are found with PROSPERO, from both
academic and international development communities.
Publish your protocol as a journal manuscript. Suggestions for journals can be found with
JMIR Research Protocols; this offers the option of submitting systematic review protocols
where no external peer reviews are available.
Publish your protocol online on a project (or other) website. Institutional websites or open
data repositories such as Fig Share are alternative options for giving your protocol an audit
trail.

Template - Protocol
Template - Checklist
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Step 4. Eligibility criteria
Eligibility criteria for the rapid review are determined in collaboration with key stakeholders. The
question framework developed for the research question is a helpful tool for defining eligibility
criteria. All aspects of this question framework should be clearly defined; for PICO, for example, the
population, intervention, comparator, and outcomes would be defined. How these elements are
prioritized will depend on the needs expressed by stakeholders. To prevent potential bias, eligibility
criteria should be created prior to screening titles and abstracts for potential inclusion; this is usually
done during the protocol development stage. Criteria should unambiguously outline what studies
will and will not be included. To ensure the timeliness of the output and to keep rapid reviews
manageable, additional restrictions may be applied to further limit the search (see Garritty et al.
2021). These additional limits can include:
1. Setting: Depending on the research question, the search could be limited to, for example, only
low- and middle-income countries (see LMIC EPOC filter).
2. Publication date: Date restrictions should be carefully considered; they should be relevant to the
research question, with a justification that is either clinical (introduction of a new intervention
type), methodological (launch of global health targets), or historical (beginning of global
economic recessions).
3. Study design: Depending on the research question, the study can include, for example, only
randomized control trials or only qualitative research. Emphasis should be placed on higherquality study designs.
4. Language: Publication language should be limited to English for conventional interventions (see
Dobrescu et al. 2021). Other language should be added if relevant results are expected to be
published in languages other than English and/or if target countries have a first language other
than English (see Garritty et al. 2021).
Template – Eligibility criteria
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Step 5. Searching for evidence
Searching information sources for relevant evidence requires the development and application of a
search strategy. A search strategy details the terms and phrases to be used in the selected
databases; experienced reviewers recommend the involvement of an information specialist in
developing the search strategy (Rethlefsen et al. 2015; Koffel 2015). Where such involvement is not
possible, peer review of the search strategy by an information specialist or, in their absence, an
experienced researcher should be considered (Garritty et al. 2021). Below we describe in detail how
to build a search strategy; explicit examples of search syntaxes developed by Transform Nutrition
West Africa can be found online on the topics of for example World Health Assembly Targets and
wasting programmes, in the region.
Various steps are required to build a search strategy:
1. Brainstorming
Terms, names, and synonyms that will make up the search syntax need to be brainstormed; these
can be built around the already-defined question framework. The PubReMiner tool is useful for
searching similar words and phrases related to the topic.
2. Building
Different Boolean operators (AND, OR, NOT, and AND
Top Tip! It is useful to build your
NOT) can be used to build the syntax. As a simple rule, search syntax in MEDLINE due to its
concepts that lie within the same element of the PICO
comprehensive searching tool and
(for example, interventions) are combined using the
vast
collection of published
“OR” operator (used for equivalents, variations, or materials.
synonyms). In contrast, concepts that relate to different
elements are combined together using the “AND” Use the MeSH (Medical Subject
Headings) feature within MEDLINE to
operator, requiring that concepts intersect. Different
search for useful subject terms
facets of the same element, however, for example age,
related to your topic. It can also be
gender and ethnicity, are also combined using AND (for
example, “adolescent AND female AND Maasai”). The useful to look for a published
systematic review which has similar
NOT operator is less frequently used, typically only to
exclude on an arbitrary basis, such as, for example, search criteria and to see which
“NOT French”; it should be used with caution because (MeSH) terms and/or databases
were searched.
it excludes not only irrelevant concepts but also those
where a relevant concept occurs alongside an irrelevant
one. “NOT child”, for example, will exclude not only
documents about children but also documents that are about both adults and children. The two
most common approaches—the “building blocks approach” and the “dropping a concept
approach”—are described by Booth (2008).
Click here to see the search syntax and log template.
3. Refining
The search can be further refined by creating limits in relation to eligibility criteria (Step 4). These
are often “filters” that can be applied within the databases, such as publication type (for example,
“systematic reviews only”), as well as date, setting, and language restrictions. A list of published
and evaluated filters is available from the UK’s National Institute for Health and Care Excellence
(NICE) Information Specialists: ISSG Search Filters Resource.
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4. Scoping
Scoping searches should be run in
order to test the sensitivity and
specificity of the search terms and
the relevance of results (The search
log template can also be used for
scoping searches)

Top Tip! Keep a record of your scoping searches. Once
you have completed multiple scoping searches it can
become confusing to remember exactly why you
dropped some terms from the syntax, or why a search
was giving too many/too few results.

5. Database selection
The number of databases to which the search strategy is applied, and the selection of databases
depends on time constraints and on the topic of the research question. The Cochrane guidelines
recommend limiting the search to CENTRAL, MEDLINE (via PubMed), and Embase (if access is
available), but this advice is specific to topics based on randomized controlled trials. Some
databases can be used for free while others require an
institutional subscription, however it is becoming more
Top Tip! Take some time to research
common for databases to offer free or reduced-fee
which database(s) will give the most
access to researchers in low- and middle-income
relevant results for your topic. Read
countries.
the database descriptions and the
• MEDLINE is the most comprehensive database disciplines on which they are focused.
Investing time on this step may save
for public health and biomedical literature.
• Searching of specialized databases can be you time later by allowing you to avoid
useful for specific topics; for example, for social searching an irrelevant database and
having to screen irrelevant literature.
science literature options include the
International Bibliography of Social Science, (For a comprehensive list of
Web of Science, and Scopus; for specific bibliographic databases and indexes,
geographic regions such as the African see
continent, use AJOL or African Indes Medicus; https://en.wikipedia.org/wiki/Categor
for psychology-related questions, use PsycInfo y:Bibliographic_databases_and_index
es.)
and CHINAHL.
6. Grey literature and supplemental searching (optional)
For some research questions, it may be useful to also search grey literature for additional
materials that may not be peer reviewed but may still contain valuable evidence. These materials
may include documents such as reports from international non-governmental organizations
(INGOs), working papers, and government reports. It may be appropriate to simplify your search
syntax and apply it to search engines such as Google, Google Scholar, or specific relevant websites
such as those of INGOs, governments, or donor agencies. A comprehensive list of grey literature
is available at https://www.cadth.ca/media/pdf/Grey-Matters_A-Practical-Search-Tool-forEvidence-Based-Medicine.doc.
If justified, a search can be conducted of clinical trial registries (at, for example, clinicaltrials.org)
or you can scan the bibliographic reference lists of included studies after screening is completed.
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7. Decision log
A log should be kept of the search,
from scoping to the final search
approach. The decisions that are
made should be logged in order to
aid follow-up research, to help keep
a record of the process, and to
justify decisions. Click here for an
example of a search syntax and log.

Top Tip! Most databases allow you to save your search
strategy by creating a personal profile. This is useful as
you may try several search strategies before deciding on
the most suitable iteration. Alternatively, cut and paste
the strategy into your search log or, if necessary, screen
capture the complete strategy so you can retype it
accurately offline.
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Step 6. Screening and study selection
Once the search is completed in the selected databases, results are brought together and identified
references are systematically screened. In selecting studies, eligibility criteria will need to be applied
in order to determine what will and will not be included in the review. Typically, this process is
conducted in two stages; first, provisional decisions are made that are based on article titles and/or
abstracts, and second, final decisions are taken which are based on full texts. Here we offer a
practical walk-through of the five steps in screening and selecting studies.
1. Export results
Once the search has been completed, download the results into a program that will allow for easy
screening. Information downloaded includes citation information such as author, date, journal,
issue, volume, and abstract for literature found in databases, and similar identifying information
for grey literature. Examples of programs include Endnote ($), Mendeley (free), or Zotero (free).
Study information can also be imported into Excel using the comma-separated values (CSV)
format. Each export file format depends on both the database/search engine and the program
that will be used to screen. Many videos are available online to describe this process, depending
on which ones are selected.
2. Duplicates
When searching in multiple databases, duplicate
references of a single study will likely be retrieved.
These need to be removed before screening. Most
bibliographic programs build in a feature that
allows duplicates to be removed, this is also
possible in Excel.

Top Tip! Keep track of the numbers of
retrieved
studies/grey
literature
documents before and after duplicate
removal, as this will feed into your
flowchart of search results (Template flowchart).

3. Title and/or abstract screening
Experts recommend that two reviewers independently screen at least 20 percent of
titles/abstracts to reduce risk of discrepancy, with conflicts discussed and resolved. One reviewer
then continues to screen the remaining titles/abstracts and a second reviewer screens all
excluded titles/abstracts (Garritty et al. 2021); this is done because single screening of
titles/abstracts likely misses out on relevant studies.
The following gives details on how to go about screening:
•

•

Screening template: Develop a standardized title/abstract screening template. Pilot test the
template using 20 percent (10 percent for large searches) of the titles/abstracts to validate
the form. The template should include the reasons for exclusion, reflecting the information
in the eligibility criteria. If the title/abstract screening is completed in Excel, it will be easier
to keep track of the numbers and reasons for exclusion (Template - screening). Screening, in
the first instance, can be based on title alone. A quick title screen can be performed to
eliminate obviously irrelevant items or to search for obviously irrelevant words in article
titles on the reference management database (for example, names of animals for reviews of
human nutrition or the word “meta-analysis” when seeking qualitative research).
Remember: Title screen to rule out.
If the title is ambiguous, then the abstract should also be read. For studies that remain
ambiguous, the reference should be retained and then read fully before the decision is made
to include or exclude the study. You should continue to include the reference and then read
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•
•

the full text before deciding to include or exclude the study. Remember: Abstract and fulltext screen: To rule in.
When two researchers disagree at the title/abstract level regarding whether a study should
be included/excluded, they can either look at the full text or involve a third researcher who
acts as a tiebreaker.
The direction of the study outcome should not be known when studies are being excluded
(positive or negative), as this will introduce bias into the results.

4. Full-text screening
Experts recommend that one reviewer screens all
included full-text articles and a second reviewer
screens all excluded full-text articles (Garritty et al.
2021). Develop a standardized full-text screening
template, which should include the reasons for
exclusion such that they reflect your eligibility criteria.
Recording your verdicts in Excel makes it easier to
keep track of the numbers and reasons for exclusion
(Template - screening)
5. Flowchart

Top Tip! The more detailed and
refined your eligibility criteria is, the
faster screening will be. Keep your
criteria to hand when screening!
When there are high levels of
ambiguity at the beginning, you will
generally end up retaining many
studies which you will likely exclude
in the subsequent rounds. It can be
hard to imagine all the potential
details of retrieved literature, but if
you have a clear and well-defined
research question, and have
completed satisfactory scoping
searches, you should have a good
idea of the literature and of what
will be included or excluded.

Results of the search for all the above steps should be
recorded in a flowchart. This will facilitate illustration
of the volume of literature retrieved, screened,
excluded, and included. Keeping accurate records
improves transparency and gives a useful visual
snapshot into the evidence base retrieved. The
PRISMA flowchart is recommended for reporting
results of any systematic approach to reviewing the literature, including scoping review, mapping
review, systematic review, or qualitative evidence synthesis (QES).
Template – Flowchart (Word)
Template – Flowchart (PPT)
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Step 7. Data extraction
Data extraction is essential for translating the important information within studies into a format
that is useful and comparable in the context of the research question. Data extraction usually, but
not necessarily, involves reading the full text of included articles and the extracting required
information using a standardized, predetermined extraction form. For some types of rapid reviews,
such as a mapping review, it may be appropriate to extract information only from abstracts.
What to extract?
Top Tip! You can use the data from
To accelerate the process, it is recommended that data
extraction be limited to a minimal set of required data
existing systematic reviews to
items. The Cochrane Collaboration recommends
reduce time spent on data
extracting data for participant, intervention, and
extraction (Garritty et al. 2021).
comparator characteristics, and for assessed outcomes
(Garritty et al. 2021). The broad categories for which
data is extracted can include general study characteristics, data relevant to the question framework,
and any other specific information related to the research question (Table 6). The decision on the
type of data extracted depends on the research question.
Table 6. Extraction categories: examples
Extraction category
General study and identifying information
Study characteristics

Examples
Reviewer’s name, date of extraction, author,
date of publication, title, journal details, type of
publication (journal article, report, abstract)
Aims, design (observational, experimental),
country/region
PICOS, SPICE, SPIDER, and other criteria

Data relevant to the research question and
inclusion criteria
Other important information relevant to the
Results, limitations, conflicts of interest,
research question
citations to follow up, reviewer comments
Source: Authors
Note: PICOS (Participants, Intervention, Comparison, Outcome, setting); SPICE (Setting, Perspective,
Intervention or Exposure or Interest, Comparison, Evaluation); SPIDER (Sample, Phenomenon of
Interest, Design, Evaluation, Research type)
Forms and tools
Standardized extraction forms improve consistency and help reduce errors. Forms should reflect the
review question and extract enough detail that the analysis can be conducted without needing to
revisit the original article. The form needs to be pilot tested and, to minimize errors, data for
outcomes should be extracted independently by two skilled extractors. Forms can be created in MS
Word or MS Excel.
Here are some helpful tips on developing the data-extraction form and how to go about data
extraction:
1. The data to be extracted (whether it be outcomes, study settings, population characteristics,
or other information) may be reported differently across the included studies. As a first step,
in order to remove any ambiguity, information should be extracted as it appears in the text.
A taxonomy can then be created, that is, data can be organized or classified into groups or
type; entries within categories can then be summarized as needed for analysis in the review.
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2. Piloting the extraction form on a set of
Top Tip! Not all data is always present in a
studies is key to ensuring that it is fit to
given article. It is important to record what
capture all the required information.
is missing in the extraction form so that it is
3. Using dropdown menus (MS Excel), or tick
clear you did not just forget to extract this
boxes (MS Word) are ways to limit errors
information. The time constraints of a rapid
in extracting standardized information.
review typically mean that findings can only
4. It is recommended that a single reviewer
be based on the information as reported; it
extract data using the piloted extraction
is not possible to contact study authors for
form. A second reviewer should then
check extractions for completeness and
missing information.
accuracy (Garritty et al. 2021).
5. Reviewers are encouraged to resolve discrepancies by discussing any differences. If this does
not resolve differences, a third opinion should be sought.
6. In a separate column, make a note of all decisions. This removes ambiguity and reduces bias,
as decisions can then easily be tracked.
Table 7 shows an indicative set of standard data-extraction elements and an additional set of
review-specific data elements. Template - Extraction is an example of how a PICO-orientated dataextraction form may look in Excel. We offer suggested categories, but in practice some will need to
be added or removed (as required by each question). Table 8 shows an overview of various review
tools which help facilitate screening, data extraction, or other steps of the review process.
Table 7. Elements of a data-extraction form
Standard data-extraction elements
Review title or ID
Study ID (surname of the first author and the
year the first full report of the study was
published, for example, (Smith 2001)
Date form completed (dd/mm/yyyy)
Name/ID of person extracting data
Participants
Types of intervention
Types of comparison
Types of outcome measures
Aim of study (such as efficacy, equivalence, or
pragmatic reasons)
Design (such as parallel, crossover, or nonrandomized controlled trial)
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Review-specific data-extraction elements
Theoretical basis (include key references)
Description (include sufficient detail for
replication, such as content, dose, or
components)
Duration of treatment period
Timing (for example, frequency or duration of
each episode)
Delivery (such as mechanism, medium,
intensity, or fidelity)
Economic information
(intervention cost, or changes in other costs as
a result of the intervention)
Resource requirements
(such as staff numbers, cold chain, or
equipment)
Outcome name
Time points measured
(specify whether this is from the start or the
end of the intervention)
Time points reported
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Table 8. Review tools
Product name

Characteristics

Abstrackr, OpenMeta[Analyst]
(open source, freely available)

Suite of products on the website of the Brown
University School of Public Health
Abstrackr is a semiautomated citation
screening software program
OpenMeta[Analyst] is software for performing
meta-analyses of continuous, binary, or
diagnostic test accuracy data
Primary screening and data-extraction tool for
Cochrane authors
Full text can be highlighted and linked to
prepare a risk-of-bias table
Data can be exported into various analytic
packages
Tool for citation import and tracking for
inclusion and exclusion
Customizable data-extraction tables
Data can be exported into various analytic
packages
Supports development of all types of
systematic reviews, including complex reviews;
includes reference management, screening,
data extraction, and risk-of-bias assessments;
contains quantitative and qualitative analysis
functions; allows coding of text and generation
of keywords

Covidence
(first review free; subscription required for
subsequent reviews)

DistillerSR
(purchase of licence required)

EPPI-Reviewer (available to Cochrane authors
free of charge; subscription fee for others)

GRADEpro GDT (freely available)

Rayyan
(freely available, web-based, includes mobile
applications)
Review Manager (RevMan)
(purchase of licence required for non-Cochrane
review use)
System for the Unified Management,
Assessment and Review of Information
(SUMARI)
(free, but registration required)
Source: Tricco, Langlois, Straus 2017.
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Software for generating evidence profiles and
summary-of-findings tables for systematic
reviews and supporting development of
guideline recommendations
Software for semiautomated screening titles
and abstracts
Contains Cochrane review template, including
tables of study characteristics, comparisons,
charts for risk-of-bias assessment, and
templates for graphical display of results;
Integrates meta-analysis software
Suite of modules for systematic reviews; this is
produced by the Joanna Briggs Institute and is
available to systematic review researchers;
includes tools for data extraction and critical
appraisal for multiple study designs;
can import and manage citations
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Step 8. Quality assessment
Quality assessment is important for establishing the extent of confidence in results and to ensure
that no harm is caused (Tricco, Langlois, Straus 2017); however, it may not be needed when the
purpose of the review is to scope the available literature rather than to evaluate specific effects.
Quality can be assessed in different ways and will differ depending on the type of studies included in
the rapid review; for example, a study design may be used as a marker of quality, but that does not
distinguish a poor trial from a well-conducted trial.
Table 9 offers an overview of the most recommended tools for assessing study quality by study
design, however, for a complete overview of tools see Ma et al., 2020. Grey literature (especially
unpublished randomized controlled trials) should be appraised to the same standard as those used
to evaluate peer-reviewed literature, using the same critical appraisal tools.
Table 9. Recommended tools for quality assessment
Systematic Randomized Nonrandomised Observational Qualitative Mixed
reviews
interventions interventions
studies*
studies
methods
AMSTAR
and
AMSTAR 2

Cochrane
risk-of-bias
(RoB 2.0)

ROBINS-I tool

CASP
checklist

NewcastleOttawa Scale
(NOS)

CASP
qualitative
research
checklist

JBI critical
appraisal
checklist

JBI critical
appraisal
checklist
for
qualitative
research

Grey
literature

Mixed
AACODS
Methods checklist
Appraisal
Tool
(MMAT)

Source: based on Ma et al. 2020
Note: * Observational studies include cohort studies, case-control studies, cross-sectional studies,
and case series
Quality assessment generally considers:
1. Appropriateness of the study design to the research question
2. Risk of bias (such as selection, performance, detection, attrition, or reporting bias)
3. Other items (such as choice of outcome measure, choice of statistical test, and
generalizability of results)
Quality assessment often occurs alongside data extraction as part of the process of becoming
sensitized to the details of each study. Below are some guiding questions for considering how quality
assessment will be integrated within the review:
•
•
•
•

Will quality assessment be used to determine inclusion/exclusion of studies? This poses a
challenge as a poor risk-of-bias or poor-quality assessment scores does not always mean there
is bias.
Will quality assessment simply be used as a tick box exercise to confirm that quality has been
assessed, without the assessment being incorporated into the analysis?
Will quality assessment be used to inform how the evidence base is interpreted, either
suppressing or amplifying results according to whether they possess lower or higher quality,
respectively?
Will graphical representations of quality assessment be used?
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Step 9. Knowledge synthesis
The best practice is to think through the analysis plan before synthesizing the extracted data. It
should be decided at the protocol stage how data will be grouped and visualized based on the
research question. This preplanning will ensure extraction of the data that will be required to
address analysis questions throughout the review.
Different approaches to analyzing and synthesizing findings: Some recommendations
1. Descriptive analysis: Provide a descriptive summary of the included studies and their general
characteristics. This helps to identify whether studies are similar and/or reliable and if any
pooling of results is possible.
2. Narrative synthesis of findings to interpret the included evidence:
o Organize synthesis around the PICO question framework elements; report results by
interventions, then by comparisons, and then by outcomes.
o Synthesize findings to determine the appropriateness of a meta-analysis.
3. Meta-analysis: this is optional for a rapid review; if feasible, aim to involve a statistician with
experience in this type of analysis.
4. Framework analysis: Occasionally, a framework or logic model may offer a useful structure
upon which to hang data, particularly if one is trying to integrate different types of data such
as, for example, quantitative and qualitative (Figure 6). Frameworks can be taken from
policy, from conceptual work, or from the program logic of an intervention or program. For
an applied example see Trübswasser et al. (2020).
5. Several strategies for synthesis are identified by Snilstveit, Oliver, and Vojtkova (2012).
Relevant tools include:
o Textual description of studies, groupings, and clusters; tabulation; transforming data
into a common rubric; vote counting as a descriptive tool; and thematic and content
analysis for translating data.
o Graphs, frequency distributions, funnel plots, forest plots, and L'Abbé plots;
moderator variables and subgroup analyses; idea webbing and conceptual mapping;
reciprocal and refutational translation; qualitative case descriptions;
investigator/moderator triangulation; and conceptual triangulation.
o Weight of evidence; best evidence synthesis; validity assessment; reflecting critically
on the synthesis process; checking the synthesis with authors of primary studies.
Graphical and visualization tools for presenting findings
As rapid reviews need to provide a solid and condensed overview of the evidence, graphical
representation and visualization tools are a useful and efficient way to transfer key results to
stakeholders. Potential tools that can be used to visualize your results are Datawrapper (free);
Flourish (free); and Tableau ($).
Best known examples are the 3ie – evidence gap maps; other examples are DataDent Landscaping
data visualisation tools for nutrition, and Transform Nutrition West Africa’s West Africa country data
profiles.
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Figure 6. Synthesis types

Source: Tricco, Langlois, Straus 2017.
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Step 10. Report production and dissemination
When preparing the final rapid review report, it is important
to consider who the end user is and the most appropriate
“Rapid reviews should prioritize the
channels for dissemination; for example, it may not be
practical needs of the primary
appropriate to go through a formal peer-review process to
knowledge user over traditional or
produce a journal article. End users may be decisionmakers
academic approaches to
(who have been involved from the beginning or throughout
dissemination, by tailoring the
the process) who need the final report as quickly as possible
message and methodological
to inform decision-making. The format and the
approach to the needs of
communication of key findings may therefore be condensed
knowledge users” Tricco, Langlois,
compared to conventional systematic reviews in peerStraus 2017; see Figure 7.
reviewed journals. This may involve first and foremost
highlighting key findings and key recommendations, with
detailed methods reported in the appendix or in a separate technical note.
Figure 7. Content to promote uptake of rapid review

Source: Tricco, Langlois, Straus 2017.
This resource bank provides all elements needed for developing the rapid review report. The
protocol developed serves as a guide for writing the report; all the ingredients necessary for
completing each step (using the templates) are provided. Examples of rapid review reports include
the evidence notes from Transform Nutrition West Africa’s “Adolescent Nutrition in West Africa”
(where findings and recommendations were published in an Evidence Note and the technical details
of the methods were published in a separate Technical Note) and one from Public Health England
entitled “Face Coverings in the Community and COVID-19: A Rapid Review”.
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Appendices
Method for creating dropdown menus in Excel
METHOD 1: Enter menu options manually
-

Select the cells you want to apply a dropdown menu to > Go to Data tab > Data Validation >
Allow: select List > Data: enter the values (i.e. items in the list you want to create) manually,
separated by commas, into the “Source:” box. e.g. nutrition, health, food security) > click OK.
There are some dangers with this option (and the other methods will work around these risks)
but it is the fastest/most common way to create a drop down menu.
You will only be able to enter values that are in the specified list.
[you can also create a customized error alert if values different from the ones specified are
entered in the cells].
Depending on what you want to do, you can allow/ignore blank values, and decide if you want
to show/hide the in-cell dropdown.

METHOD 2: Refer to a data range
-

This method involves entering the data somewhere else in the Excel workbook, and specifying
that the dropdown menu available refers to the data range in the Data Validation settings.
Create list of values in table form (instead of entering manually in Data Validation window) >
select cells where you want to apply the dropdown menu > go to the Data tab > Data
Validation > Settings screen > Allow: List > Select range of cells that contain your list
In this case, in the ‘Source:’ box, instead of the actual list of items separated by a comma, you
will see the range of cells that contain your list (e.g. A1-A10) > click OK
If you change the items in the table, it updates the dropdown menu available for filling the
cells (e.g. if Ministry of Agriculture changes name to Ministry of Agriculture and Rural Affairs),
but it will still refer to the range of cells you had selected at the beginning.

METHOD 3: Update the dropdown menu whenever needed, without going into Data Validation
every time
-

-

-

With this method, you can both change items within the existing list AND add as many items
as you like (helpful in our case, e.g. if you have different countries for which you want to
extract data and each country has peculiarities – e.g. groupings of tasks under a particular
ministry – e.g. Ministry of Agriculture and Rural Development in one country / Ministry of
Agriculture, Forestry and Fisheries in another country; or if recurring items specific to a given
country warrant for additional options in dropdown menu; or if the protocol keeps evolving
over weeks/months and you want the changes to be reflected in the dropdown lists).
Create a list of values that you want to be in your dropdown menu in table form (either on
the same worksheet or on a different worksheet in the same Excel file – best to use the second
option, then the worksheet with data ranges can be hidden, e.g. if you don’t want users to
edit the list) and your worksheets will be neat. Make sure you’ve entered a header for your
list (it will make things easier for you later).
Select the table/data range you just entered (including the header), and create an Excel Table
by going to Insert > Table from the Excel Ribbon (or by using the shortcut Ctrl + T). > Click OK
when the dialog box appears. > Tick box ‘my table has headers’.
(optional but useful because you will recognise it in Data Validation instead of just having
Table1, Table2… - better to have e.g. Table_Sector or T_Sector, etc. – you will have these
names as suggestions when you go to data validation later – also useful if you apply the same
table/dropdown menu to different columns): You can change the Table name on the top-left
under File > Table tools > Table name > change name directly from the box below Table
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-

name > click Return (remember to click return or it won’t apply the name!). [You can also do
this last step through Name Manager > Define name etc. but it’s easier and quicker this way].
[note: Excel treats Tables differently – i.e. Tables for which you have told Excel that they are
tables, as in this case. For this reason, you will be able to add and change items and it will still
treat them as part of the table, whatever form and length it takes, as opposed to the method
above where the list in table form was not officially a Table but a range of cells. Items within
those cells would be changed / items beyond those cells would not be added, resulting in a
partially updatable dropdown menu].

The tricky bit: apply formula
-

-

Select the cells/column where you want to apply the dropdown menu (might be a different
worksheet from the one where you have your tables) > Data > Data Validation > Allow: List >
in the “Source:” box enter INDIRECT formula: =INDIRECT(“TableName”) > click OK. e.g.
=INDIRECT(“T_Sector”)
Done. Test your dropdown menu.
[If it’s not working, check spaces, inverted commas, parentheses, etc.].
[If you make mistakes or you want to permanently delete a dropdown menu, you can easily
click ‘Clear All’ in data validation and repeat the process].
[optional: To hide the worksheet with all your dropdown menu tables, go to the worksheet’s
name tag at the bottom of Excel file > right-click > Hide. To unhide, go to nametag of other
worksheet that is visible at the bottom of Excel file > right-click > Unhide].
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Example of a data-extraction form
Data extraction form (template) from Duvendack, M, Mader, P. Impact of financial inclusion in
low‐ and middle‐income countries: A systematic review of reviews. Campbell Systematic Reviews.
2019; 15:e1012. https://doi.org/10.4073/csr.2019.2

Data
extraction
items

Details

1. Context

• Source
• Author
• Publication year
• Geographical focus (e.g., continent, countries and regions)
• Funding source

2. Type of
intervention

• Details of the population as discussed in the reviews (e.g., household, individual,
enterprise; type of finance user, i.e., multiple borrower/saver, repeat
borrower/saver; gender or other person characteristics, e.g., women focus or
youth focus)
• Broad category—type of product/service offered, ensure intervention has at least
one essential financial service element
• Detailed sub‐category of product (e.g., credit to existing businesses only, group
savings account, etc.)
• Comparator, i.e., comparing against nothing at all or against the next best
alternative
• Duration of intervention (e.g., length of exposure to intervention)
• Modality of intervention—group vs individualLocation of intervention—urban/rural
• Focus on women only (yes/no)

3. Type of review;
design and
methods

• Research question and review objectives—list actual question, plus clearly stated
(yes/no)
• Inclusion criteria—clearly stated (yes/no)
• Search methods—e.g., number of databases, dates of search provided, search
strategy/key words provided, additional search methods reported, any search
restrictions (by language, timeframe?)
• Study selection methods—clearly reported (yes/no), independent screening, full
text review, consensus procedure for agreements
• Number of included studies
• Types of included studies
• Types of data extraction methods—clearly reported (yes/no), independent
screening
• Types of data synthesis approaches (quantitative/qualitative)
• Subgroup analysis conducted (yes/no)
• Discussion of publication bias (yes/no)
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Data
extraction
items

Details

4. Outcome
measures

• Outcome definition, i.e., type of outcome measure to be grouped by social,
economic, behavioural
• Unit of measurement (e.g., at household or individual level, composition of
empowerment indices)

5. Quality
assessment

• Quality of review methods, their use and application—to be assessed using data
extracted as part of “3. Type of review; design and methods” which will feed into
AMSTAR rating
• GRADE rating provided (yes/no)
• Name of other quality assessment tools and their quality scores
• Researcher bias/Conflict of interest

6. Study results
and findings

• For each outcome:
○ Sample size
○ Type of effect size
○ Magnitude and direction of effect size, if reported, to allow comparison
across included studies

PRISMA – Scoping Reviews (PRISMA-ScR) Checklist
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Preferred Reporting Items for Systematic reviews and Meta-Analyses extension for
Scoping Reviews (PRISMA-ScR) Checklist - 20 essential reporting items and 2 optional items
SECTION

PRISMA-ScR CHECKLIST ITEM

REPORTED
ON PAGE #

1

Identify the report as a scoping review.

Click here to
enter text.

2

Provide a structured summary that includes (as
applicable): background, objectives, eligibility
criteria, sources of evidence, charting methods,
results, and conclusions that relate to the review
questions and objectives.

Click here to
enter text.

ITEM

TITLE
Title
ABSTRACT
Structured
summary
INTRODUCTION
Rationale

3

Objectives

4

METHODS
Protocol and
registration

5

Eligibility criteria

6

Information
sources*

7

Search

8

Selection of
sources of
evidence†

9

Data charting
process‡

10

Data items

11

Critical appraisal
of individual
sources of
evidence§

12
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Describe the rationale for the review in the context
of what is already known. Explain why the review
questions/objectives lend themselves to a scoping
review approach.
Provide an explicit statement of the questions and
objectives being addressed with reference to their
key elements (e.g., population or participants,
concepts, and context) or other relevant key
elements used to conceptualize the review
questions and/or objectives.
Indicate whether a review protocol exists; state if
and where it can be accessed (e.g., a Web
address); and if available, provide registration
information, including the registration number.
Specify characteristics of the sources of evidence
used as eligibility criteria (e.g., years considered,
language, and publication status), and provide a
rationale.
Describe all information sources in the search (e.g.,
databases with dates of coverage and contact with
authors to identify additional sources), as well as
the date the most recent search was executed.
Present the full electronic search strategy for at
least 1 database, including any limits used, such
that it could be repeated.
State the process for selecting sources of evidence
(i.e., screening and eligibility) included in the
scoping review.
Describe the methods of charting data from the
included sources of evidence (e.g., calibrated forms
or forms that have been tested by the team before
their use, and whether data charting was done
independently or in duplicate) and any processes
for obtaining and confirming data from
investigators.
List and define all variables for which data were
sought and any assumptions and simplifications
made.
If done, provide a rationale for conducting a critical
appraisal of included sources of evidence; describe
the methods used and how this information was
used in any data synthesis (if appropriate).
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Click here to
enter text.

Click here to
enter text.

Click here to
enter text.
Click here to
enter text.
Click here to
enter text.
Click here to
enter text.
Click here to
enter text.

Click here to
enter text.

Click here to
enter text.
Click here to
enter text.

SECTION
Synthesis of
results
RESULTS
Selection of
sources of
evidence
Characteristics of
sources of
evidence
Critical appraisal
within sources of
evidence
Results of
individual sources
of evidence
Synthesis of
results
DISCUSSION

ITEM
13

14

15
16
17
18

Summary of
evidence

19

Limitations

20

Conclusions

21

FUNDING
Funding

22

PRISMA-ScR CHECKLIST ITEM
Describe the methods of handling and summarizing
the data that were charted.
Give numbers of sources of evidence screened,
assessed for eligibility, and included in the review,
with reasons for exclusions at each stage, ideally
using a flow diagram.
For each source of evidence, present
characteristics for which data were charted and
provide the citations.

REPORTED
ON PAGE #

Click here to
enter text.
Click here to
enter text.
Click here to
enter text.

If done, present data on critical appraisal of
included sources of evidence (see item 12).

Click here to
enter text.

For each included source of evidence, present the
relevant data that were charted that relate to the
review questions and objectives.
Summarize and/or present the charting results as
they relate to the review questions and objectives.

Click here to
enter text.

Summarize the main results (including an overview
of concepts, themes, and types of evidence
available), link to the review questions and
objectives, and consider the relevance to key
groups.
Discuss the limitations of the scoping review
process.
Provide a general interpretation of the results with
respect to the review questions and objectives, as
well as potential implications and/or next steps.
Describe sources of funding for the included
sources of evidence, as well as sources of funding
for the scoping review. Describe the role of the
funders of the scoping review.

Click here to
enter text.
Click here to
enter text.
Click here to
enter text.
Click here to
enter text.
Click here to
enter text.

JBI = Joanna Briggs Institute; PRISMA-ScR = Preferred Reporting Items for Systematic reviews and MetaAnalyses extension for Scoping Reviews.
* Where sources of evidence (see second footnote) are compiled from, such as bibliographic databases, social
media platforms, and Web sites.
† A more inclusive/heterogeneous term used to account for the different types of evidence or data sources (e.g.,
quantitative and/or qualitative research, expert opinion, and policy documents) that may be eligible in a scoping
review as opposed to only studies. This is not to be confused with information sources (see first footnote).
‡ The frameworks by Arksey and O’Malley (6) and Levac and colleagues (7) and the JBI guidance (4, 5) refer to
the process of data extraction in a scoping review as data charting.
§ The process of systematically examining research evidence to assess its validity, results, and relevance before
using it to inform a decision. This term is used for items 12 and 19 instead of "risk of bias" (which is more
applicable to systematic reviews of interventions) to include and acknowledge the various sources of evidence
that may be used in a scoping review (e.g., quantitative and/or qualitative research, expert opinion, and policy
document).
From: Tricco AC, Lillie E, Zarin W, O'Brien KK, Colquhoun H, Levac D, et al. PRISMA Extension for Scoping Reviews (PRISMAScR): Checklist
and Explanation. Ann Intern Med. 2018;169:467–473. doi: 10.7326/M18-0850.
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PRISMA (PRISMA) Checklist and Flow chart
Preferred Reporting Items for Systematic reviews and Meta-Analyses (PRISMA) Checklist - 27 reporting items 7 (some with multiple

elements a,b,c)
Section and
Topic

Item
#

Location
where item
is reported

Checklist item

TITLE
Title

1

Identify the report as a systematic review.

ABSTRACT
Abstract

2

See the PRISMA 2020 for Abstracts checklist.

INTRODUCTION
Rationale

3

Describe the rationale for the review in the context of existing knowledge.

Objectives

4

Provide an explicit statement of the objective(s) or question(s) the review addresses.

METHODS
Eligibility criteria

5

Specify the inclusion and exclusion criteria for the review and how studies were grouped for the syntheses.

Information
sources

6

Specify all databases, registers, websites, organizations, reference lists and other sources searched or consulted to identify studies. Specify the
date when each source was last searched or consulted.

Search strategy

7

Present the full search strategies for all databases, registers and websites, including any filters and limits used.

Selection process

8

Specify the methods used to decide whether a study met the inclusion criteria of the review, including how many reviewers screened each record
and each report retrieved, whether they worked independently, and if applicable, details of automation tools used in the process.

Data collection
process

9

Specify the methods used to collect data from reports, including how many reviewers collected data from each report, whether they worked
independently, any processes for obtaining or confirming data from study investigators, and if applicable, details of automation tools used in the
process.

Data items

Study risk of bias
assessment
Effect measures
Synthesis
methods

10a

List and define all outcomes for which data were sought. Specify whether all results that were compatible with each outcome domain in each
study were sought (e.g. for all measures, time points, analyses), and if not, the methods used to decide which results to collect.

10b

List and define all other variables for which data were sought (e.g. participant and intervention characteristics, funding sources). Describe any
assumptions made about any missing or unclear information.

11

Specify the methods used to assess risk of bias in the included studies, including details of the tool(s) used, how many reviewers assessed each
study and whether they worked independently, and if applicable, details of automation tools used in the process.

12

Specify for each outcome the effect measure(s) (e.g. risk ratio, mean difference) used in the synthesis or presentation of results.

13a

Describe the processes used to decide which studies were eligible for each synthesis (e.g. tabulating the study intervention characteristics and
comparing against the planned groups for each synthesis (item #5)).

13b

Describe any methods required to prepare the data for presentation or synthesis, such as handling of missing summary statistics, or data
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Section and
Topic

Item
#

Location
where item
is reported

Checklist item
conversions.

13c

Describe any methods used to tabulate or visually display results of individual studies and syntheses.

13d

Describe any methods used to synthesize results and provide a rationale for the choice(s). If meta-analysis was performed, describe the
model(s), method(s) to identify the presence and extent of statistical heterogeneity, and software package(s) used.

13e

Describe any methods used to explore possible causes of heterogeneity among study results (e.g. subgroup analysis, meta-regression).

13f

Describe any sensitivity analyses conducted to assess robustness of the synthesized results.

Reporting bias
assessment

14

Describe any methods used to assess risk of bias due to missing results in a synthesis (arising from reporting biases).

Certainty
assessment

15

Describe any methods used to assess certainty (or confidence) in the body of evidence for an outcome.

RESULTS
Study selection

16a

Describe the results of the search and selection process, from the number of records identified in the search to the number of studies included in
the review, ideally using a flow diagram.

16b

Cite studies that might appear to meet the inclusion criteria, but which were excluded, and explain why they were excluded.

Study
characteristics

17

Cite each included study and present its characteristics.

Risk of bias in
studies

18

Present assessments of risk of bias for each included study.

Results of
individual studies

19

For all outcomes, present, for each study: (a) summary statistics for each group (where appropriate) and (b) an effect estimate and its precision
(e.g. confidence/credible interval), ideally using structured tables or plots.

Results of
syntheses

20a

For each synthesis, briefly summarize the characteristics and risk of bias among contributing studies.

20b

Present results of all statistical syntheses conducted. If meta-analysis was done, present for each the summary estimate and its precision (e.g.
confidence/credible interval) and measures of statistical heterogeneity. If comparing groups, describe the direction of the effect.

20c

Present results of all investigations of possible causes of heterogeneity among study results.

20d

Present results of all sensitivity analyses conducted to assess the robustness of the synthesized results.

Reporting biases

21

Present assessments of risk of bias due to missing results (arising from reporting biases) for each synthesis assessed.

Certainty of
evidence

22

Present assessments of certainty (or confidence) in the body of evidence for each outcome assessed.

DISCUSSION
Discussion

23a

Provide a general interpretation of the results in the context of other evidence.

23b

Discuss any limitations of the evidence included in the review.
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Section and
Topic

Item
#

Location
where item
is reported

Checklist item

23c

Discuss any limitations of the review processes used.

23d

Discuss implications of the results for practice, policy, and future research.

OTHER INFORMATION
Registration and
24a
protocol
24b
24c

Provide registration information for the review, including register name and registration number, or state that the review was not registered.
Indicate where the review protocol can be accessed, or state that a protocol was not prepared.
Describe and explain any amendments to information provided at registration or in the protocol.

Support

25

Describe sources of financial or non-financial support for the review, and the role of the funders or sponsors in the review.

Competing
interests

26

Declare any competing interests of review authors.

Availability of
data, code and
other materials

27

Report which of the following are publicly available and where they can be found: template data collection forms; data extracted from included
studies; data used for all analyses; analytic code; any other materials used in the review.

From: Page MJ, McKenzie JE, Bossuyt PM, Boutron I, Hoffmann TC, Mulrow CD, et al. The PRISMA 2020 statement: an updated guideline for reporting systematic reviews. BMJ 2021;372:n71. doi:
10.1136/bmj.n71

For more information, visit: http://www.prisma-statement.org/
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Preferred Reporting Items for Systematic reviews and Meta-Analyses (PRISMA) Flow Diagram
Identification of studies via databases and registers

Records identified from*:
Databases (n = )
Registers (n = )

Records removed before
screening:
Duplicate records removed (n
=)
Records marked as ineligible
by automation tools (n = )
Records removed for other
reasons (n = )

Records screened
(n = )

Records excluded**
(n = )

Reports sought for retrieval
(n = )

Reports not retrieved
(n = )

Reports assessed for eligibility
(n = )

Reports excluded:
Reason 1 (n = )
Reason 2 (n = )
Reason 3 (n = )
etc.

Identification of studies via other methods

Records identified from:
Websites (n = )
Organisations (n = )
Citation searching (n = )
etc.

Reports sought for retrieval
(n = )

Reports assessed for eligibility
(n = )

Reports not retrieved
(n = )

Reports excluded:
Reason 1 (n = )
Reason 2 (n = )
Reason 3 (n = )
etc.

Studies included in review
(n = )
Reports of included studies
(n = )

*Consider, if feasible to do so, reporting the number of records identified from each database or register searched (rather than the total number across all databases/registers).
**If automation tools were used, indicate how many records were excluded by a human and how many were excluded by automation tools.
From: Page MJ, McKenzie JE, Bossuyt PM, Boutron I, Hoffmann TC, Mulrow CD, et al. The PRISMA 2020 statement: an updated guideline for reporting systematic reviews.
BMJ 2021;372:n71. doi: 10.1136/bmj.n71. For more information, visit: http://www.prisma-statement.org/
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Toolbox - Published guidelines/guidance for different review types
Illustrative guidelines/guidance of common review types

Systematic Review
Mapping Review
Scoping Review
Review of Reviews
Meta-analysis
Meta-ethnography
Qualitative Evidence
Synthesis
Rapid Review
Rapid Qualitative
Evidence Synthesis
Realist Synthesis

Procedure
Manuals/ Papers
Higgins et al.
(2019)
James et al. (2016)

Protocols

Reporting Guideline

Shamseer et al.
(2015)
CEE (2018)

Page et al. (2020)

Arksey and
O’Malley (2005)
Smith et al. (2011)

Peters et al. (2020)

Tricco et al. (2018)

Aromataris et al.
(2020)
Shamseer et al.
(2015)
Not known

Pollock et al. (2020)

Higgins et al.
(2019)
Campbell et al.
(2011)
Noyes et al. (2019)
Garritty et al.
(2020)
Guide to
conducting rapid
QES for HTA
RAMESES –
Training Materials

Tricco et al. (2018)

Published Audits
Borges Migliavaca et al.
(2020)
Not known

Page et al. (2020)

Available from Andrew
Booth
Available from Andrew
Booth
Ballard and
Montgomery (2017)
Shamseer et al. (2015)

France et al. (2019)

SBU (n.d.)

Glenton et al. (2020)

Tong et al. (2012)

SBU (n.d.)

Not known

Under development 1

Not known

Hannes and Macaitis
(2012)
Marshall et al. (2019)

Glenton et al. (2020)

Tong et al. (2012)

SBU (n.d.)

Campbell et al. 2019

Not known

RAMESES – realist
synthesis

Quality standards

Berg and Nanavati.
(2016).

HTA = Health Technology Assessment; QES = Qualitative Evidence Synthesis

1

Quality Assessment
Checklists
Shea et al. (2017)

Tricco et al. (2016)
Lunny et al. (2017, 2018)
Multiple, e.g. Plana et al.
(2020)
France et al. 2014

https://www.equator-network.org/library/reporting-guidelines-under-development/reporting-guidelines-under-development-for-systematic-reviews/
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